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FINANTSÖKONOMEETRIA ÜLESANDED

ÜLESANDED I 
Teemad: Tutvumine programmiga Stata. Sesoonne aegrea mudel SARIMA ja prognoosimine. Sesoonsuse filtreerimine: Christiano-Fitzgeraldi ja Hodrick-Prescotti filter. Periodogramm.

Ülesanne 1. Tutvumine programmiga Stata					Andmefail ceosal.dta
Andmete ja tunnustega tutvumine, kirjeldav statistika, sagedustabelid, korrelatsioonimaatriks, hajumisdiagramm, lineaarse mudeli hindamine (OLS), mudeli testimine.

1. Stata faili ceosal.dta avamine 	File->Open

Andmebaasis on 209 USA ettevõtte andmed, mis on võetud ajalehest Businessweek (6. mai 1991) ja avaldatud õpikus Wooldridge[footnoteRef:1]. [1:  Wooldridge, J. M. Introductory Econometrics, 2nd ed., 2002] 


salary		ettevõtte tegevjuhi aastane töötasu 1990. a, tuh $
sales		ettevõtte käive 1990. aastal, mln $
roe		omakapitali rentaablus (%), aastate 1988-1990 keskmine
finance		fiktiivne tunnus, =1 kui finantsvaldkonna ettevõte

2. Andmete kirjeldus
Data > Describe data > Describe data in memory or in a file
	In memory

3. Andmetabeliga tutvumine
Data->Data Editor->Data editor (Browse)

[image: ]Võib kasutada ka nupureal olevat ikooni 

4. Tunnuste haldur.
Data->Variables manager
Saab vajadusel muuta tunnuste nimesid ja kirjeldusi.
Numbriliselt kodeeritud tunnuste korral saab lisada ja muuta silte valikus Value label. Näiteks tunnuse finance korral valida Value label->Manage. Seal näeb, kuidas erinevad koodid on sildistatud. 

5. Tegevuste ja tulemuste salvestamiseks tuleb käivitada tegevuste logimine. 
File -> Log ->Begin
Logifailile tuleb anda nimi. Logifaili võib salvestada kahes formaadis:
	Formatted Log (*.smcl)	Sobib avamiseks programmis Stata.
	Log (*.log)			Sobib avamiseks muus programmis, näiteks Notepad, Word.
Salvestada logi endale sobivas formaadis.

6. Kirjeldav statistika. Kirjeldava statistika esitamiseks on mitmeid erinevaid võimalusi: standardne ja detailne komplekt ning lisaks kasutaja poolt valitud näitajate kuvamine kompaktsel ja keerulisemal kujul koos salvestamisega erinevates formaatides.
a) Detailne kirjeldav statistika iga tunnuse kohta
Statistics > Summaries, tables, and tests > Summary and descriptive statistics > Summary statistics
Valida välja arvulised tunnused salary, sales ja roe.
Valida Display additional statistics	ja 	OK.

Vasakul on protsentiilid. Protsentiili 1% väikseim väärtus (smallest) on miinimum. Protsentiil 50% on mediaan. Protsentiili 99% suurim (largest) on maksimum.
Paremal on vaatluste arv, kaalude summa (antud juhul on iga vaatluse kaal 1), aritmeetiline keskmine, standardhälve, dispersioon (variance), asümmeetriakordaja  (skewness) ja püstakuse kordaja (kurtosis). Panna tähele, et töötasu salary ja käibe sales asümmeetriakordaja ning püstakuse kordaja on suured.

b) Selles kirjeldava statistika aruandes ei kuvata variatsioonikordajat, mille alusel saab erinevates ühikutes mõõdetud tunnuste varieerumist võrrelda. Variatsioonikordaja ja mitmete teiste kirjeldava statistika näitajate kuvamiseks tuleb kasutada kirjeldava statistika tabelit.
Statistics > Summaries, tables, and tests > Other tables > Compact table of summary statistics

Valida välja tunnused salary, sales ja roe.
Valikus on palju erinevaid kirjeldava statistika näitajaid. Korraga saab kuvada kuni 8 erinevat näitajat. Valida järgmised
	Statistics to display 	Mean, Maximum, Minimum, Range, Coefficient of variation

Valitud näitajad võib leida ka eraldi finantsvaldkonna ja teiste ettevõtete korral. Selleks
		Group statistics by variable:		 finance
Kuvatakse valitud näitajad kahes ettevõtete grupis ehk alamvalimis ja terves valimis.

7. Kommentaaride lisamine logifaili. Kasutajapoolse kommentaari lisamiseks tuleb käsureale sisestada tärn ja selle järele soovitud kommentaar. Näiteks käsuaknasse
* See oli kirjeldav statistika

8. Sagedustabelite moodustamine. Kvalitatiivse tunnuse kirjeldav statistika on selle erinevatele väärtustele vastavate objektide osakaalud valimis. Antud juhul saab leida osakaalud fiktiivse tunnuse finance alusel.
Statistics > Summaries, tables, and tests> Frequency tables > One-way table
Categorical variable 		finance

9. Korrelatsioonimaatriks. Leida korrelatsioonikordajad kvantitatiivsete tunnuste salary,  sales ja roe vahel. kahes grupis eraldi: finantsettevõtetel ja teistel.
Statistics > Summaries, tables, and tests > Summary and descriptive statistics > Pairwise correlations
Korrelatsioonikordaja statistilise olulisuse märkimiseks märkida
Significance level for displaying with a star

Lehel by/if/in 	valida Repeat command by groups ja sisestada 	finance

On näha, et mittefinantsvaldkonna ettevõtete korral on statistiliselt oluline korrelatsioon suuruste salary ja roe vahel. Finantsettevõtete korral statistiliselt olulist korrelatsiooni ei esine.

Märkus: korrelatsioonimaatriksi saab ka sama menüü teisest valikust
Statistics > Summaries, tables, and tests > Summary and descriptive statistics > Correlations and covariances, kuid seal ei saa hinnata korrelatsiooni statistilist olulisust.

10. Hajumisdiagramm tunnuste sales ja salary vahel.
Graphics > Twoway graph (scatter, line, etc.).
Create	
Basic plots, Scatter 
Y variable 	salary		X variable 	sales
	Accept
Ok

Diagrammid avanevad eraldi aknas Graphs. Neid logifailiga ei salvestata,  soovi korral võib eraldi salvestada.

11. Regressioonmudeli hindamine hariliku vähimruutude meetodil (OLS).

Kuna kirjeldav statistika ja histogrammid näitasid, et tunnustel salary ja sales on tugev asümmeetria, kasutada mudelis nende logaritme ja hinnata mudelit

	 

a) Tunnuste salary ja sales logaritmid tuleb eelnevalt luua. Uute tunnuste nimede ette lisame logaritmi tähistava tähe l. Uute tunnuste loomine käib käsuga generate. Selleks käsuaknasse
	generate l_salary = ln(salary)
	generate l_sales = ln(sales)

b) Lineaarse regressioonmudeli hindamine
Statistics > Linear models and related > Linear regression

Dependent variable		l_salary
Independent variables	l_sales roe finance

Tutvuda mudeli aruandega.

12. Mudeli testimine. Erinevad testid peale regressioonmudeli hindamist leiab menüüst
Statistics > Linear models and related > Regression diagnostics > Specification tests, etc.

Heteroskedastiivsuse ja jääkide normaaljaotuse testimine. Võib kasutada informatsioonimaatriksi IM testi (imtest). Informatsioonimaatriksi test on üldine mudeli spetsifikatsiooni test[footnoteRef:2]. Võib tuvastada mitut tüüpi vigu korraga: [2:  Cameron, A. C., and P. K. Trivedi. 1990. The information matrix test and its applied alternative hypotheses. Working Paper 372, University of California-Davis, Institute of Governmental Affairs] 

· heteroskedastiivsus (eraldi saab lasta kuvada White’i heteroskedastiivsuse testi);
· valesti valitud funktsionaalne kuju;
· puuduvad olulised tunnused;
· valed jaotuslikud eeldused (jäägid ei allu normaaljaotusele);
· endogeensusega seotud probleemid (kaudselt).
Test ei ütle, mis täpselt on valesti – ainult, et midagi on valesti.

Information matrix test (imtest). 
Perform White’s original heterosekedasticity test

Et testide valiku aken jääks lahti, valida 
Submit

Tulemus: 
heteroskedastiivsus puudub, p= 0,9938 (nullhüpotees);
asümmeetria vastab normaaljaotusele, p= 0,3642 (nullhüpotees);
püstakus vastab normaaljaotusele, p=0,1378 (nullhüpotees);
kokku nullhüpotees, p= 0,8693, ei ole probleeme mudeli spetsifikatsiooniga.

Märkus: mitmed autorid on näidanud, ei ole jääkide normaaljaotuse testimiseks informatsioonimaatriksi test eriti sobiv ning jääkide normaaljaotust tuleks vajadusel testida eraldi[footnoteRef:3], eelnevalt jäägid salvestada. [3:  Vt näiteks Baltagi, B. H., Econometrics, 5th ed., lk 203.] 


Mudeli kuju testimine eraldi Ramsey RESET testiga.
Ramsey regression specification-error test ….

Tulemus: nullhüpotees, mudeli kuju on õige.


Ülesanne 2. Sesoonne ARIMA mudel ja prognoosimine.			Footwear.dta
Tarbijate kulutused jalatsitele

Tarbijate kulud jalatsitele (mln GBP) Suurbritannias, kvartaalsed andmed 1985:1– 2021:3. Allikas UK National Accounts, The Blue Book time series[footnoteRef:4]. [4:  https://www.ons.gov.uk/economy/nationalaccounts/satelliteaccounts/timeseries/adiy/ct#] 


Tutvuda andmetega. Panna tähele, mis formaadis on kvartalid.
Aegridade korral tuleb näidata, milline tunnus vastab ajale. Selleks deklareerida, et quarter on ajamuutuja kvartalites.
Statistics > Time series > Setup and utilities > Declare dataset to be time-series data

Tutvuda aegrea diagrammiga.
Graphics > Time-series graphs > Line plots
Luua graafik Plot, kus Y variable on FW.

Veenduda, esineb eksponentsiaalne trend ja kvartaalne sesoonsus. Sesoonsed komponendid  suurenevad.
Eksponentsiaalse trendi eemaldamiseks tuleb algul logaritmida ja logaritmidest leida 1. järku diferentsid. Käsu generate asemel võib kasutada ka sama käsu lühemat varianti gen
gen l_FW = ln(FW)
Diferentside leidmiseks kasutada diferentsimise operaatorit D, millel järgneb punkt
gen dl_FW = D.l_FW
Tutvuda logaritmide diferentside aegrea diagrammiga.
Esimest järku diferentsidest leida nüüd sesoonsed diferentsid. Arvestada, et sesoonsuse periood on 4 kvartalit ja kasutada operaatorit S4, millele järgneb punkt.
gen sddl_FW= S4.dl_FW
Tutvuda sesoonsete diferentside sddl_FW  korrelogrammidega.
Autokorrelatsiooni ACF korrelogramm.
Graphics > Time-series graphs > Correlogram(ac)
Maksimaalseks viitaegade järguks (Autocorrelations) võtta 15.

Korrelogramm avaneb diagrammide aknas. Et see diagramm jääks alles, kui soovime uut tekitada, anda Edit menüüst nimi, näiteks ac
Osalise autokorrelatsiooni PACF korrelogramm
Graphics > Time-series graphs > Partial Correlogram(ac)
Ka siin võtta maksimaalseks viitaegade järguks 15.

Vaikimisi saab vaadata vaid üht diagrammi. Et vaadata korraga mõlemat, lohistada hiirega tab ac  allapoole ja valida New Horizontal Tab Group.
Et diagrammid alati avaneksid eraldi akendes, tuleb muuta programmi seadistusi
	Edit > Preferences > Graph preferences
	Eemaldada märge	Open documents in tabs instead of windows.

Tutvuda korrelogrammidega. On näha, et esineb nii mittesesoone kui ka sesoonne komponent. Kuna PACF korrelogrammil sesoonsusele vastavad kordajad vähenevad ja ACF diagrammil on üks nullist erinev sesoonsusele vastav kordaja, on sesoonne MA. Panna tähele, et PACF korrelogrammil on nullist erinevad ka 5. ja 9. viitajale vastavad kordajad. See on tingitud interaktsioonist. 
Selge pole, mis on mittesesoonne komponent, kas AR või MA. 

Sobiva mittesesoonse komponendi leidmiseks tuleks hinnata erinevaid mudeleid ja valikuks kasutada informatsioonikriteeriumit. Kuna sesoonne komponent on määratud (SMA), siis tuleks varieerida mudelites vaid mittesesoonset komponenti ja  logaritmide 1. järku diferentside sesoonsete diferentside jaoks hinnata mudeleid 
ARMA(1,0)× (0,1)4
ARMA(0,1)× (0,1)4 
ARMA(1,1)× (0,1)4    

Sobivate mittesesoonsete ARMA järkude leidmiseks informatsioonikriteeriumite järgi võib kasutada Stata vastavat võimalust, kus hinnatakse automaatselt etteantud järkudega mudeleid ja leitakse nende informatsioonikriteeriumid.
Statistics > Time series > ARIMA and ARMAX -> lag order selection

Dependent variable	sddl_FW
Maximum AR order	1
Maximum MA order	1	 	

Seda, et sesoonne komponent on  määratud, saab näidata valikus Arima options.
Seal märkida
	Moving-average order Q	1
	Seasonal lag S			4

Hinnatakse nelja erinevat mudelit, kus varieeruvad mittesesoonsed AR ja MA ning kuvatakse 
LL		logaritmiline tõepära (log-likelihood)
df		vabadusastmete arv
AIC		Akaike informatsioonikriteerium
BIC		Schwarzi ehk Bayesi informatsioonikriteerium
HQIC		Hannan-Quinni informatsioonikriteerium
On näha, et kolme kriteeriumi järgi on sobivaim mittesesoonne mudel ARMA(1,1).

Eesmärgiks on mitte diferentside prognoosimine, vaid algse aegrea FW prognoosimine. Selleks on vaja eelnevalt prognoosida logaritmitud väärtused. 
Logaritmide 1. järku diferentside sesoonsete diferentside jaoks on mudel ARMA(1,1)× (0,1)4    
Logaritmitud väärtuste l_FW jaoks on järelikult mudel ARIMA (1,1,1)× (0,1,1)4  
Statistics > Time series >ARIMA and ARMAX ->  ARIMA and ARMAX models
	Dependent variable		l_FW
ARIMA specification		
Autoregressive order 		1	
Integrated (difference) order 1
Moving-average order	1
Sesoonse komponendi lisamiseks minna lehele Model 2
	Integrated (difference) order 1
Moving average order 	1
	Seasonal lag			4

Kuvatakse mudeli hindamise aruanne, kus on mudeli kordajad, standardvead, z-statistikud (normaaljaotusest), olulisuse tõenäosused p ja usalduspiirid. 
Waldi test (Wald chi2, Prob > chi2) testib mudeli kui terviku statistilist olulisust. See on suurima tõepära meetodi korral analoogne F-testiga OLS-i korral.
Viimasel real olev sigma on jääkide standardhälve.

Panna tähele, et mudelis olev konstandi korral p=0,971, see ei ole statistiliselt oluline. Kuna hindamiseks kasutatakse suurima tõepära meetodit, mitte OLS-i, võib konstandi mudelist eemaldada. Lisaks: ARIMA mudeli aruandes tähistab konstant aegrea keskväärtust ja keskväärtus võib olla 0.

Hinnata sama mudelit ilma konstandita. Selleks valida mudeli spetsifikatsiooniaknas 
Suppress constant term

Kas mudel muutus konstandi eemaldamisel paremaks? Selleks oleks vaja teada ka selle mudeli Akaike informatsioonikriteeriumit. Kuid mudeli aruandes seda ei kuvata ja see tuleb eraldi leida. Selleks on kaks võimalust
a) Menüüst Postestimation > Specification, diagnostic, and goodness -of-fit analysis
Launch > Information criteria

b) Käsureale	estat ic
AIC väärtus -424,85 on veidi väiksem kui konstandiga mudeli korral -422,86. Järelikult mudel paranes.
Tuleb testida, kas valitud mudeli jääkliikmed moodustavad valge müra. Selleks tuleb jääkliikmed salvestada ja siis vaadata korrelogrammilt nende Q-statistikut ja selle olulisuse tõenäosust.
Jääkliikmete salvestamiseks 
Statistics > Postestimation > Predictions > Means from the differenced and ….   Launch

Jääkliikmete nimeks 	res 
Valida			Residuals or predicted innovations 
Testida, kas jäägid on valge müra, st autokorrelatsioon puudub. Selleks tuleb kasutada autokorrelatsiooni ning osalise autokorrelatsiooni ning vastava Q-statistiku arvutust.
Statistics > Time-series >Graphs > Autocorrelation & partial autocorrelations
Variable	res

Vaadata viimasele viitajale 40 vastava Q-statistiku olulisuse tõenäosust. 
Tulemus: p= 0,9880, vastu võtta nullhüpotees. Autokorrelatsioon puudub, jäägid on valge müra.

Prognoosimine. Tuleb leida FW logaritmide prognoositud väärtused. Staatiline prognoos valimi sees ja dünaamiline prognoos valimist välja 5 kvartalit, st kuni  2022. aasta  4. kvartal.
Dünaamilise prognoosi tegemiseks valimist välja tuleb andmebaasi lisada 5 väärtust.
Statistics > Time series > Setup and utilities >  Add observations to time-series dataset
Veenduda, et andmetabelisse lisati 5 väärtust.

Prognoositud väärtuste leidmiseks mudeli põhjal
Statistics > Postestimation > Predictions > Means from the differenced and ….   Launch

Nimeks näiteks l_FW_hat
Mida prognoosida	Values for mean equation in y – the undifferenced series
Dünaamiline prognoos peab algama 2021. a. 4. kvartalist. Selle määramiseks lehel
Options -> Switch to dynamic predictions at time
tq(2021q4)
Siin tq tähistab seda, et sulgudes olev väärtus on aeg kvartalites.

Kui FW logaritmide prognoositud väärtused on leitud, tuleb FW prognoosimiseks arvutada uus tunnus, mis on arv e astmel logaritmi prognoositud väärtus
gen FW_hat = exp(l_FW_hat)
Nüüd võib kuvada graafiku, kus on nii tegelikud FW väärtused kui ka prognoositud väärtused
Graphics > Time-series graphs > Line plots
Tuleb luua kaks graafikut (Plot), kus ühel on FW väärtused ja teisel FW_hat väärtused.

Prognoosimisvõime hindamiseks Stata põhipaketis head võimalust pole. Tuleb installeerida abipakett fcstats[footnoteRef:5]  Abipaketi installeerimiseks käsureale [5:  Christopher F Baum, 2017. "FCSTATS: Stata module to compute time series forecast accuracy statistics," Statistical Software Components S458358, Boston College Department of Economics, revised 14 Jul 2018.] 

	ssc install fcstats
Abiinfo saab käsuga
	help fcstats

Kasutamiseks tuleb ette anda tunnuste nimetused: tegelikud väärtused ja prognoositud väärtused
	fcstats FW FW_hat

Kuvatakse 4 näitajat. 
              FW_hat
RMSE          98.672271	juuritud keskmine ruutviga (root mean square error)
MAE           48.555737	keskmine absoluutviga (mean absolute error)
MAPE          .03475619	keskmine suhteline absoluutviga (mean absolute percentage error)
Theil's U     .28815642	näitab, kas prognoos mudeli järgi on parem kui naiivne prognoos

MAPE on esitatud kümnendmurruna, seega protsentides 3,48%.


Ülesanne 3. Sesoonne filtreerimine	.				Andmefail võetakse veebist
USA tööstustoodangu indeks

Kasutame Stata juhendiga kaasas olevat andmefaili, kus on USA tööstustoodangu indeksi logaritmitud väärtused. Kvartaalsed andmed 1919 I kvartal kuni 2010 IV kvartal. Eesmärgiks on analüüsida äritsükleid.

1. Andmefaili avamiseks käsureale
use https://www.stata-press.com/data/r17/ipq
2. Tutvuda andmete ja tunnustega. Panna tähele, et tunnus daten on antud kuupäevana, tunnus tq aga kvartalitena. Ajamuutujana tuleb kasutada viimast tunnust.
3. Deklareerida, et ajamuutuja on tq.
4. Tutvuda logaritmitud indeksi ip_ln aegrea diagrammiga. Järgnevalt rakendada filtreid sellele aegreale.
Burns ja Mitchell[footnoteRef:6] defineerisid äritsüklid kui ostsillatsioonid majandusaegridades perioodiga 1,5 kuni 8 aastat. Lähtuda nende definitsioonist. [6:  Burns, A. F., and W. C. Mitchell. 1946. Measuring Business Cycles. New York: National Bureau of Economic
Research.] 


5. Christiano-Fitzgeraldi filter. See on ribafilter ja tuleb ette anda vahemik, millised sagedused läbi lastakse. Kuna aegrida on kvartaalne, tuleb perioodid anda kvartalites: 1,5 aastat on 6 kvartalit ja 8 aastat on 32 kvartalit. Filtri abil luuakse uued tunnused: tsükliline komponent ja trend. Mõlemale tuleb anda nimi. Et selle filtri abil leitud trendi ja tsüklilist komponenti eristada järgmise, HP filtri rakendamisel saadutest, kasutame nimetamisel tähistust cf
a) Filtri rakendamine
Statistics->Time series-> Filters fo cyclical components -> Christiano-Fitzgerald
Original series		ip_ln
New variable names/stub	c_cf
Minimum period		6
Maximum period		32
Lehel Trend 			t_cf
b) Tutvuda trendi ja tsüklilise komponendi graafikutega. Võib panna ühele diagrammile.
c) Et hinnata, kui hästi on äritsüklitele vastava sagedusega ostsillatsioonid eraldatud, tutvuda aegrea c_cf periodogrammiga, kus esitatakse spektraaltiheduste graafik.
Graphics->Time series graphs->Periodogram

Panna tähele, et sageduse maksimaalne väärtus on 0,5. Sellele vastav periood on 2 kvartalit: lühema perioodiga (ehk suurema sagedusega) ostsillatsioone kvartaalsete andmete korral olla ei saa.

6. Hodrick-Prescotti filter on kõrgpääsfilter, mis laseb läbi kõik sagedused, mis on suuremad määratud väärtusest. Aegrida jagatakse kaheks: trend + ostsilleeruv komponent ja sobib kasutamiseks siis, kui soovime eraldada siledat trendi ja edasi tegeleda sellega. Filtri rakendamisel tuleb ette anda silumisparameeter λ. Kvartaalsete andmete korral on selle soovituslik väärtus 1600.
a) Rakendada aegreale ip_ln Hodrick Prescotti filtrit, salvestades nii tsüklilise komponendi c_hp kui ka trendi t_hp
Smoothing parameter		1600
b) Tutvuda tsüklilise komponendi periodogrammiga. 
c) Luua diagramm, kus on 3 joont: filtreerimata aegrida ip_ln, trend t_hp ja ostsilleeruv komponent c_hp. Tutvuda diagrammiga ja veenduda, et trend on sile.


ISESEISEV TÖÖ

Ülesanne 4. Euroala jaekaubandus, SARIMA mudel ja        			retail trade.dta
prognoosimine. 

Andmebaasis on euroala (19 riiki) jaekaubanduse käibe indeks perioodil 2009 1. kvartal kuni  2023 3.  kvartal, sesoonselt korrigeerimata. Andmed on võetud portaalist FRED[footnoteRef:7]. Eesmärgiks on leida sobiv SARIMA mudel ja teha prognoos 2024. aasta 4. kvartalini. [7:  Organization for Economic Co-operation and Development, Sales: Retail Trade: Total Retail Trade: Value for Euro Area (19 Countries) [EA19SLRTTO02IXNBQ], retrieved from FRED, Federal Reserve Bank of St. Louis; https://fred.stlouisfed.org/series/EA19SLRTTO02IXNBQ, January 29, 2024.] 

1. Deklareerida, et ajamuutujaks on quart.
2. Tutvuda aegrea rt graafikuga. Veenduda visuaalselt, et 
a) aegreal on eksponentsiaalne trend; 
b) esineb kvartaalne sesoonsus, sesoonne komponent mõnevõrra suureneb.
3. Eksponentsiaalse trendi eemaldamiseks 
a) logaritmida;
b) logaritmidest leida 1. järku diferentsid. 
c) Tutvuda logaritmide diferentside aegrea diagrammiga ja veenduda visuaalselt, et trend õnnestus eemaldada.
4. 1. järku diferentsidest leida veel sesoonsed diferentsid, arvestades et sesoonsus on 4 kvartalit.
5. Tutvuda sesoonsete diferentside  diagrammiga. Kas sesoonsus õnnestus täielikult eemaldada?
6. Uurida leitud sesoonsete diferentside korrelogramme.  
a) Kas mittesesoonne osa on pigem AR või MA? 
b) Kumb multiplikatiivne sesoonne liige tuleks mudelisse lisada, kas SAR või SMA? 
7. Võttes sõltuvaks tunnuseks logaritmide 1. järku diferentside sesoonsed diferentsid, leida milline kolmest mudelist: ARMA(1,0)×(0,1)4; ARMA(0,1)×(0,1)4; ARMA(1,1)×(0,1)4  on AIC alusel sobivam. Milline on AIC põhjal parim mudel?
8. Kuna algse aegrea prognoosi leidmiseks on vaja leida logaritmide prognoos, siis hinnata käibe logaritmi vastava mudeliga,  arvestades et mittesesoonse integreerimise järk on 1 ja sesoonse integreerimise järk on 1. Kas konstant on statistiliselt oluline?
9. Hinnata sama mudelit ilma konstandita. Kas konstandi eemaldamisel mudel paranes? Võrrelda konstandita ja konstandiga mudelite Akaike informatsioonikriteeriume.
10. Järgnevalt tuleb kontrollida, kas väljavalitud mudeli korral jääkliikmed moodustava valge müra (autokorrelatsioon puudub). 
a) Salvestada jääkliikmed. 
b) Testida Q-statistiku alusel, kas jäägid moodustavad valge müra.
11. Logaritmi prognoosimine valimi sees ja dünaamiline prognoos valimist välja, st 5 kvartalit edasi kuni 2024 4. kvartal.
a) Lisada andmebaasi 5 väärtust.
b) Prognoosida aegrea logaritmi nii, et dünaamiline prognoos algaks 2023q4. 
c) Kui suur on käibe indeksi logaritmi prognoos 2024.a. 4. kvartalil?
12. Käibe indeksi prognoosimine. 
a) Lähtudes käibe indeksi logaritmi prognoositud väärtustest genereerida valemi järgi uus tunnus, mis vastab indeksi prognoositud väärtustele. 
b) Kui suur on käibe indeksi prognoositud väärtus 2024. a 4. kvartalis?
13. Kasutada lisamoodulit fcstats, et leida erinevad prognoosimisvõimet iseloomustavad näitajad valimi sees, mis võrdlevad tegelikku käibe indeksit ja prognoositud käibe indeksit.
14. Tutvuda aegrea diagrammiga, kus on nii tegelikud väärtused kui ka prognoositud väärtused.

Ülesanne 5. Eesti keskmine kuupalk ja Hodrick-Prescotti filter			kuupalk.dta

Andmefailis on Eesti keskmine brutokuupalk perioodil 2000. a jaan kuni 2022 dets, kõik tegevusalad[footnoteRef:8]. Eesmärgiks on siluda seda Hodrick-Prescotti filtriga. [8:  Eesti Statistikameti andmebaas. https://andmed.stat.ee/et/stat Tabel PA006 KESKMINE BRUTOKUUPALK TEGEVUSALARÜHMA JÄRGI (2000–2022, KUUD)] 


1. Deklareerida, et ajamuutujaks on kuu.
2. Tutvuda aegrea diagrammiga. Panna tähele, et esineb nii trend kui ka sesoonsus.
3. Sileda trendi leidmiseks kasutada Hodrick-Prescotti filtrit. Kuna tegemist on kuiste andmetega, võtta silumisparameetriks 100 000. Salvestada ka trend.
4. Tutvuda trendi diagrammiga.
5. Kui suur on trendi väärtus 2022.a detsembris?

Ülesanne 6. Uute autode müük ja äritsüklid.					autode_myyk.dta
Ribafilter ja periodogramm

Andmefailis on uute autode müük USA-s, kvartaalsed andmed 1975 1. kv kuni 1990 4. kv.

1. Tutvuda aegrea diagrammiga ja veenduda, et trendi pole.
2. Tutvuda aegrea periodogrammiga. Võrdluseks vt loenguslaidi „NÄIDE: uute autode müügi spekter“
3. Kui tahame äritsükleid paremini välja tuua, on mõistlik kasutada Baxter-Kingi ribafiltrit. Riba laiuseks valida 16 kuni 32 kvartalit. 
4. Uurida eelmises punktis salvestatud tsüklilise komponendi periodogrammi. Et maksimumi sagedust täpsemini määrata, tasub x-teljele lisada jaotised tihedamalt. Selleks aknas Periodogram valida lehel X axis Minor tick/label properties ning määrata Suggest between major ticks	10.
5. Millise sageduse juures asub spektraaltiheduse maksimum?
6. Kui suur on sellise tsükli periood?


VASTUSED

Ül. 4. 3.c)

[image: ]

5. 1. järku diferentside sesoonsete diferentside aegrea diagramm
[image: ]

6. ACF
[image: ]

PACF
[image: ]
6.a) Raske otsustada. 6.b) SMA, sest ACF diagrammil on ainult 4. järku viitajale vastav kordaja oluliselt nullist erinev. 7. Sobivaim mudel on see, kus mittesesoonne osa on ARMA(1,0), selle mudeli korral AIC= -272,6263.8) 8. Ei ole oluline, p=0,079. 9. Konstandita mudeli korral AIC = - 268,618, mudel paranes. 10. Jäägid moodustavad valge müra. Viitajale 25 vastava Q-statistiku olulisuse tõenäosus on 0,9873, autokorrelatsiooni ei esine. 11.c) 5,01453. 12.b) 150,5854. 
12.        
RMSE          2.018819
MAE           1.1600809
MAPE          .01043319
Theil's U     .21657325
13. 
[image: ]

Ül. 5.  4. Silutud trendi diagramm, vt järgnevat diagrammi. 7. 2022. detsembris 1716 eurot.

[image: ]
Ül 6. 4. Periodogramm peale Baxter_Kingi filtrit, vt järgnevat diagrammi. 5. Ligikaudu 0,03. 6. 33 kvartalit.
[image: ]
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